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Bz

RFEMEN BUMIERAK/SKEZIANEL VR FEIAPIM XA =ARSSAPI, 1244t
BEMESICMBEE, LA&kJava. Go. Python. CEZSMARENESHIEZSDKINER

N/

MR

1.

O RARSFRMAIAPI, FBIFAPINXK, EZINEREBELEESERRSBSRMUNAPIZSE
Fifto
BRRSAPISEFMDPY “WEAMBAPI” BT, NMATIANERE.

SDKITETERAIS, nIEMIRENSDK, ARESERFISZIESAIAPIERIRAEEES , 1SSDKEE
RREMERIRI R .

MRAFHNSESEBRMIREREERERANGREES, PIRIEESRESSEE, B
WMIBERAIZEZ .

APIEREBS—MNES X oiES Token, TokenAATHBSREIG S EZIREBIIAPISEE
o

AK/SKEZINERT, (XNS2iFBodyfR A/NA12MULA, 12MUAERYIESK, FE{ERATokeniA
ik,

=IRESEMRRIAPIEZ ZIRZAIAPIZSE F AT,
i)ﬁ'ﬁﬁiﬁﬁ%‘\mmwrEﬂ'—ﬁﬁa‘quJHE%%%E’ﬂEﬁ, B ISR B SLX-Sdk-Date B H IR KIR
APIR KR T RISATERE VSN, RS RISIZATEE S X EERAVETEZE, INREZEB
121595, APIRSISIELIER .
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AK/SK B2 \IEEEI¥AR

2.1 AK/SK EZIMIERIE

EFims RBIAK/SKEZUAMIER AIERRIEELAYI T -

1. 1EEIEIERKR.
BiEAENE RN ZREBSAPINXGEESATERIMNELE, MREFIiRESS. AP
WX B STAERERINERAET—H .

2. (FRIEIEXRINEMEEIEFEER/TE

3. (FRHAK/SKIIFEZHFRITESEE,

4. BERMNEREEERNEREELFIEHTTPERY, EEATEIZRFESH
RINEIHTTPIS kRS,

LATHMOEENE.,

(AL

AELEERTHEUWAFBITTMAPIERIESE
FESDKSdemoETiRI T EBIESHIRZSDKLARdemo, SAETIREMNELBE—H,
BAILUEEER, sXE825R.

2.2 IIEHEIEK

{EFAK/SKERHITER SINE, BEFEEIERAT, AEBHITER. BRI
S=IRSZAPIMKERERANERIE, AILASRE—HTTPIERAIRIEIRSEIEE
IERER, MMz B R,

HTTPIERALEHARBIN T :

CanonicalRequest =
HTTPRequestMethod + '\n' +
CanonicalURI + '\n' +
CanonicalQueryString + '\n' +
CanonicalHeaders + '\n' +
SignedHeaders + '\n' +
HexEncode(Hash(RequestPayload))

UEMFAE IR — 1 EIBVPCHIRIZO A, IRIBAEIERAMTELS R

BRIRIRIAIERK:
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2 AK/SK BZINEER¥RR

I3

GET https://serviceregion.example.com/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs?
limit=2&marker=13551d6b-755d-4757-b956-536f674975c0 HTTP/1.1

Host: service.region.example.com

X-Sdk-Date: 20191115T033655Z

KMIEHTTPIER A% ( HTTPRequestMethod ) , LUAITIF4EER
HTTPiER AL, fIGET. PUT. POSTE ., &K E5MA:

GET

HIIHBEURIZBE ( CanonicalURI) , LURITRFER.

B

HSEURI, BNERERERER, RURIRIBITIRZEHBSHIURIZRES .
&t

FRYERFC 3986/ B URIEER, BIRTTRIMEXIIRERES, BEHENIHBIMAURI
8. WNRURIBBEARLL “/7 FEE, WEESRHM “/7 .

241

URIEAN=RSZBAIAPIZSEZFA, BPAPIEDENRMITNAVERIZR . MEINAE S
RSB HIEIAVPCEIE: /v1/{project_id}/vpcs, IATHISEAIURIZRAD S :

GET
/v1/77b6ad4cba5143ab91d13ab9a8ff44fd/vpcs/

(AR
ITEEERT, URIBRLL /7 ER . RIEXEKRRT, LA ¢/ &R,

FIEEEIAF/FE ( CanonicalQueryString ) , LUg{T1545%,
BX:
BiFHE, NEPSH. NRLAENSH, WH=FHR, MIEEIERNE
175
Bt
MeEAFHFEEEREUTRS:

o RIBUTHNTENSHIFEHITURIZR:
- IBZDXIRFC 3986 E X ANEAIEFABFZFTHITURIZRED, XLEFRFEIE: A-Z,
a‘Z\ 0'9\ TN N ~*D~0
- (FAR%XYNErBEIERBFEHITEOLRE, EPXFYA+9#E=RF (0-9
FIA-F) . 00, SBEEFVNIIREHN%20, T RUTF-8ZHFIRA “ %XY
%ZA%BC” &=,
o WFBNSHE, BN “ URIGIEBHISHEH=URIGGIEBHIZSHE" . IRZESH
B, WAZZFRRE, BREeaE ‘=7
FIINLATEEWm 23, ERE - s HparmIEAST,

parmi1=value1&parm2=

o ERFHABLUAFRINFNSHZHTHF. I, UIXEFEFFLNSHEHE
FELUNSFEOFFLRIZH A ZH .

o LUIFEMNE—SHZTE, WEIEEAFGS,
41
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EAVPCHIRBAWENESE: limit (BTUREINEL ) . marker ( S TAEIIAYEIR
VPCEIEID )

GET

/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs/
limit=2&marker=13551d6b-755d-4757-b956-536f674975c0

SINALEIEESL ( CanonicalHeaders ) , LURITREE
B
ALEEEL, ENBEKERLIIER, SEEZBERFIFFBHTTPEELTIE, HESLY

MEEX-Sdk-Date, FFRIGEZATE, #&zL91SO8601HBAYIUTCATEIHEL:
YYYYMMDDTHHMMSSZ.,

A EE
ﬁ{i‘%@E%ﬁﬁiﬂﬂﬁlﬁ]'—iﬁﬁ*ﬁﬁ%éﬁﬂgE5, B IERIE B LX-Sdk-Date 9B HINEL
==
APIRKBR T IRIEATEIREN A, B RIIZAT B ES MW EERAIATEIZE, GNSRATE
EiBid15954%h, APINIEIZIELEERK.

Bt

CanonicalHeadersHAZMEKIBELHE4ER, CanonicalHeadersEntry0 +
CanonicalHeadersEntry1 + ..., EFE/MEKESL ( CanonicalHeadersEntry ) B9
& ILowercase(HeaderName) + "' + Trimall(HeaderValue) + '\n'

MR

o LowercaseRTNEFRIEFEFHEIR N/ NEZRAIRE
o TrimalEFRRMRKERIFRIS RTHEIRE

o RE—MERBEBABSET—MRTH . BINME+CanonicalHeaders B SETHRIRIT
F, Et=BR—1 =T,

2451

HAVPCIIRRIBERL, TECEEEMTE (X-Sdk-Date ) , =ARSSEndpoint
(Host) . ZEZEEY ( Content-Type) o

GET

/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs/
limit=2&marker=13551d6b-755d-4757-b956-536f674975c0

content-type:application/json

host:service.region.example.com

x-sdk-date:20191115T033655Z
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+1R6

ikl

AEHRLFTEREUATAS:

o FHBABMEIRINER, FHRRRISTEIERMTR
o REBFHAENBERABMEITHRHF
LIRSS E SR

Host: service.region.example.com\n
Content-Type: application/json;charset=utf8\n
My-headerl: a b c \n
X-Sdk-Date:20190318T094751Z\n
My-Header2: "x y \n

XHELEMENG, RBELEMFHANBXEELARE, BHERLNEXENS
TREEMTR .. REREIIEEEEL:

content-type:application/json;charset=utf8\n

host:service.region.example.com\n

my-headerl:a b c\n

my-header2:"x y\n
x-sdk-date:20190318T094751Z\n

FINAFEZA9EELER ( SignedHeaders ) , LUR{TEF4ER,

BX:

BFEZRNEKREELIIER, BITRINLGEESL, [APIMNXSEEINERFPFLEESLE
B2 —E29, AR ERIFSRATAPINEA LA ZERBLEE R L, X-Sdk-datedssR
EREEZRIEEL,

B

SignedHeaders = Lowercase(HeaderName0) + ;' + Lowercase(HeaderName1) + ;"
+ ..

EERIESAFTERENNE: BESBRBEBLBMELIRNNERNL, RERFN
KBXHEEHTHER, FHER 7 kRSN ERL
LowercaseRNGFTBE F R NINEFE

2545

UTERE=1EELE25%%: Content-Type. Host. X-Sdk-Date
GET

/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs/
limit=2&marker=13551d6b-755d-4757-b956-536f674975c0
content-type:application/json

host:service.region.example.com

x-sdk-date:20191115T033655Z

content-type;host;x-sdk-date

BREBEELEN:

SignedHeaders=content-type;host;x-sdk-date

HELRINEERIEAROIESERINEREREIBREL

{SFASHA 256157 HEIARFHTTPEHTTPSIERIESZ FAIbody Ak
( RequestPayload ) , EIZENEHE,

BY:
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2 AK/SK BZINIEER1ERR

BKBEER ., BERTEMMERE: HexEncode(Hash(RequestPayload)), EHH
HashRRERHERENRE, HaikiESHA-2568%, HexEncodeRRLUNEFHE
FezbiRElEERIBase- 160w AL, #1401, HexEncode("m") IREHES “6d” MA=
“6D” ., BMINHNB—INEDEERTRAWNHNHEIER

(RERTY:
ITERequestPayload MG FEAT, XJF “RequestPayload==null” 19155, BEEFERZFHEHE
"SRtE,
Z55):
ARBINGETHE, bodylfhz, FidnaF4ERIbody (== ) WTF:
GET

/v1/77b6ad4cba5143ab91d13ab9a8ff44fd/vpcs/
limit=2&marker=13551d6b-755d-4757-b956-536f674975c0
content-type:application/json
host:service.region.example.com
x-sdk-date:20191115T033655Z

content-type;host;x-sdk-date
e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855

Elt, FCIEREIETTH

BT IHESFAINSEIERHITIHEIE, EiXS5%IRequestPayloadlSFH A IBRIELLERE]

ZPIAFLRIBHREEIER B RUNE R #H = TR R R

&% L8 Lowercase(HexEncode(Hash.SHA256 (CanonicalRequest)))
ZP IR IBHIHLEIE R
b25362e603ee30f4f25¢7858e8a7160fd36e803bb2dfe206278659d71a9bcd7a

et

2.3 BIERFEF TS

MIHTTPIEREFTHEEHESERIGRERS, KESEEE X, KB E—RAENSF
BRFMH.
StringToSign =

Algorithm + \n +
RequestDateTime + \n +
HashedCanonicalRequest

RS EURAUT
e Algorithm

BEEE, XTFSHA 256, BiEASDK-HMAC-SHA256,
e RequestDateTime

ERATEE . SiEREBAX-Sdk-DatefHERR, KRXH
YYYYMMDDTHHMMSSZ,

e HashedCanonicalRequest
AEHGEIERPEIERIIEIERIASHA256 B AL Ak hashfE

EIRBIFERINGFEFRERN:

SDK-HMAC-SHA256

20191115T0336552
b25362e603ee30f4f25¢7858e8a7160fd36e803bb2dfe206278659d71a9bcd7a
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2.4 1HEHERZ

$5SK ( Secret Access Key ) FNBIZBRYFEZFRIENINZIAHZREAIEMAN, TESE
B, BisEE R OEEIRTER

RCHBEN T

signature = HexEncode (HMAC(Secret Access Key, string to sign))

HAHMACGIEZBIEXMINSFIZE, HexEncodefgit+75it4l . (B Eu5ABTN
xR2-1FiR,

% 2-1 SHuRA

SHEWR SHRE
Secret Access Key TE2EB
string to sign SIS

{Bi&Secret Access Key AMFyfvK41ba2gigM7Uio6PznpdUKGpownRZImVmHc, Rit
H18Ff¥signaturey:

7be6668032f70418fcc22abc52071e57aff61b84a1d2381bb430d6870f4f6ebe

2.5 LR EREERL

FITEEEE, BEeiamzlAuthorizationBIHTTPEESL . AuthorizationjHE3LRE
BEEERBEY, FERTFEMWIE,

{AFCRIENT

Authorization headerfZ2{5%3:
Authorization: algorithm Access=Access key, SignedHeaders=SignedHeaders, Signature=signature

BEFIENREIESAccessZBIBTIEEIRFIES, {BRSignedHeaders5Signature
ZHIREFRESR.

BREINERERLI:

SDK-HMAC-SHA256 Access=QTWAOYTTINDUT2QVKYUC, SignedHeaders=content-type;host;x-sdk-date,
Signature=7be6668032f70418fcc22abc52071e57aff61b84a1d2381bb430d6870f4f6ebe

BRI EHELE, BHIBNIIFBHTTPIERAET, BRERARIEE=IRSAPIN
K, HAPINXFTHSDINE. BIMAMEETE, ZERTSREEEFRNRRSHT
AVSS4hiE

BABEIEEEEERIT:

GET /v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs?limit=2&; marker=13551d6b-755d-4757-
b956-536f674975c0 HTTP/1.1

Host: service.region.example.com

Content-Type: application/json

x-sdk-date: 20191115T033655Z

SASRRZS 01 (2024-02-18) WRIERE © HERRARBIRAT 7
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Authorization: SDK-HMAC-SHA256 Access=QTWAOYTTINDUT2QVKYUC, SignedHeaders=content-
type;host;x-sdk-date, Signature=7be6668032f70418fcc22abc52071e57aff61b84a1d2381bb430d6870f4f6ebe

Curl75 =0T :

curl -X GET "https://service.region.example.com/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs?
limit=2&marker=13551d6b-755d-4757-b956-536f674975c0" -H "content-type: application/json" -H "X-Sdk-
Date: 20191115T033655Z" -H "host: service.region.example.com" -H "Authorization: SDK-HMAC-SHA256
Access=QTWAOYTTINDUT2QVKYUC, SignedHeaders=content-type;host;x-sdk-date,
Signature=7be6668032f70418fcc22abc52071e57aff61b84a1d2381bb430d6870f4f6ebe" -d $"

SASRRZS 01 (2024-02-18) WRIERE © HERRARBIRAT 8
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3 AK/SK BEZINIBREES:

AK/SK EZI\IHE{EIE S

3.1 AK/SK EZ I IHEERIE

AK/SKEZINIFRERIENT:

1. APIEAR(EEWE.

=ERBLATER, 8

- AFHEIEKURLAYENdpointFIURI,
- BTFESTAUERIAK/SK,

- RBFXHEFIREID. FIREID,
- BFXSEFIRSE. KSID,

- BT HostHiFEEE.,

% 3-1 1§:§\W§§<Iﬁ

{ERI0

1A

Endpoint

WX S5®IFT R, BI=RSZEAERegionEARERISIEIE
B

RENS X 1ES EFKENEndPoint,

URI

APIEONERRBRENRSE.
B2 ESIRSINEMEOETIRE,

AK/SK

IPIEERYY, AEEHIDEER. AK/SKRETHERRAFIH
1TESZ.

SKENS B2 EIKEIAK/SK

Project_Id

IMBID, AAZHAPIELIFANFERETURIF, ALUR
AIARRERIRE

RIS UIESEIREIEID,

SASRRZS 01 (2024-02-18) WRIERE © HERRARBIRAT 9
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3 AK/SK BEZINIBREES:

S0

Lz

X-Project-1d

FIMEID, EZMBFSEHER. MRERSKFEOIEEF
IMEA, AK/SKAELRT, Pz RINZEOEREER
BRI R LHPH#ETEX-Project-1d.

RIS RIBSEIRIREID .

X-Domain-Id

WK=ID, F&:
e TokenAiES T, F¥KEX Token,

o AK/SKINEAR T, £BRSHIEOER, EEEKRER
SLehfEX-Domain-ld, ( £BIRS: IRSBERFAXS
YIFBX1E ., YIOBS. CDNZ, )

RSB E RIS ZHWSID,

Host

APIEO TR 2 BRI A B IR
IE2E B RIRSHIEOFRBAPIDEPIIERER .

2. APIER,

AFMEMava. Go. Python. CHEZSMARIESRIE S SOKAIERASRAI, &0
LINEZSDKSdemo I FRENNES, ARSERGISAPIRRIRBEED, &
SDKEEREISRIN FEH

(11 588

APLERERIAMIAIE, thIFIGATAK/SK, BERiESEMEAIGIAK/SKEES .

3.2 3%BY EndPoint

X S5RiFTHR, BERSEARERegionERERNAEES
RIS HESEMXAEHR TR

AR

AFEMEFBXTFIERURLAYZEG, EREndpointlAservice.region.example.com/afil,

3.3 3KEX AK/SK

WNRELERITAK/SK, WATHEMIIEE, FHEIRKE TEHAIAK/SKXE, XHB—RR

79 credentials.csv,

WNTNERRR, AK (Access Key Id) , SK ( Secret Access Key ) o

3-1 credential.csv XHERE

A

1 |User Name Access Key ld

B C

Secret Access Key

2 hummmedz QTWAGEEEEBUT2OVKYUC MFyfvKalba2guieemeeen pdUKGpownRZImYmHc

N5k 01 (2024-02-18)
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AP 2157 3 AK/SK BEZINIBREES:

BAESER
ST BREHE.
$B2 SRITBEREA LANAFEL, ETHFIRRRE RIOEE” .

------

SIEBAPIFIX
P (AP Gaten

mmmmm

S$|3 BE “piaERT .
$IRA B “FHHEER" , HA ENEEAE" NHE.
SIS MAEIRER, B “BE” , THER, BEZERE

3-2 FXENAHIaZA
hiEEHE @

O usrn=muE. cesEuENE,

CIEHEN
HFEEID = &miE = BIEERE =
OWDKSINQ7WOBTZIWEBYEPC ahnigbaihg 2021/07/12 15:35:13 GMT+08:00
(10 88
IREUIGATAK/SK, 1BEEIAMIZON,
e

3.4 3REXIH ID
FERFEOMAIIR, MOURLPESENARERS, HKiltokenty, EHFHEHEAE
/S, MUBBAEERRHA LFNERERS . RERSHESEIT:
1. BRIBHA,

2. BESBRERNEALANAFREL, ETRSIFRPSEE “HIOFILE , EF ‘I
HID” .
B AT aRS =R FEHTIERE, BiAGregionBIRIfRE, tLAITE
Region MEUZIMH, MEMAKINRE. Eit, 555 TE, EAMIFRS L
FTRIBRS R RIERI N AIRegion (PTEXE ) , FEHZAMZIFRPIREIIEID,

3-3&EFMABE ID

APIEIE @
© BREATHS, AMFRFITEVERES, BeERE
caseofost
FEdes ~  w&s . kEmEE
sadscof

07e67efE i aEn
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https://console-intl.huaweicloud.com/
https://support.huaweicloud.com/intl/zh-cn/api-iam/iam_04_0002.html
https://console-intl.huaweicloud.com/
https://support.huaweicloud.com/intl/zh-cn/usermanual-iam/iam_05_0001.html

AP 2157 3 AK/SK BEZINIBREES:

MERLL
MRESFEFREID, BRHZMAE, BRAFRBESIRERN.

3.5 IRENIK SEZFKS 1D

ERAEOREHE, B2 URLPERBEAKSZFKSID, IAFESAEEERSS
EIREVEIKSEMKSID . WSEFKSIDIRENE RN T:

1. BREFE,
2. BEFBRENEALANAFREL, ETFRSIRPSEE “BREIE” .
BEKSEMKSID,

3-4 EEKSZMKS ID

3.6 £ SDK 5 demo

3.6.1 Java

AT LAEclipse TEAA, M BIUNMEE avalMEREERRAPIEREZAISDK,, BRILIERE
SNCHEEHFHROITERS, AESEEAIRBERDEER SOKEREIGFINF

F.
EFNE
o RENFHZEEclipse, AJZEEclipseER MU FEAIHRITXEHFHITRE, B THSE
EXRBEHBESERER.
e JDK: Java Development Kit 1.8.111 %A EARA, BJZEOracleE/S FERE F
(o B ASz1F)ava Development Kit 178kLA_ERRAS .
e MavenGitiit: https://repo.huaweicloud.com/apache/maven/maven-3/,
¥REX SDK
mUtt FESDKSDemo,
RIEEEREMWNT:
2R 5iRH
libs\java-sdk-core-x.x.x.jar FBASDKLAR (KIS

libs\commons-codec-x.x.jar

SZHERRAN 01 (2024-02-18) WRIERE © HERRARBIRAT 12


https://console-intl.huaweicloud.com/
https://www.eclipse.org/downloads/
https://www.oracle.com/technetwork/java/javase/downloads/index.html
https://repo.huaweicloud.com/apache/maven/maven-3/
https://obs.cn-north-1.myhuaweicloud.com/apig-sdk/APIGW-java-sdk-3.1.2.zip

APl 2157 3 AK/SK EZINIBREES:

2R 588

libs\commons-logging-x.x.jar

libs\httpclient-x.x.x.jar

libs\httpcore-x.x.x.jar

src\com\apig\sdk\demo\Main.java FR2IERTHILH
classpath ARG TS
.project

f0java-sdk-corefkEfifImavenE BN :

<dependency>
<groupld>com.huawei.apigateway</groupld>
<artifactld>java-sdk-core</artifactld>
<version>SDKEILRZS< /version>
</dependency>

SZHERRAN 01 (2024-02-18) WRIERE © HERRARBIRAT 13
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(AR
B mavent@ZEAY, settingsxmUEFHREEN, BIIATHSE:
1. fEprofiles T =R IMANTAS:

<profile>
<id>MyProfile</id>
<repositories>
<repository>
<id>HuaweiCloudSDK</id>
<url>https://mirrors.huaweicloud.com/repository/maven/huaweicloudsdk/</url>
<releases>
<enabled>true</enabled>
</releases>
<snapshots>
<enabled>false</enabled>
</snapshots>
</repository>
</repositories>
<pluginRepositories>
<pluginRepository>
<id>HuaweiCloudSDK</id>
<url>https://mirrors.huaweicloud.com/repository/maven/huaweicloudsdk/</url>
<releases>
<enabled>true</enabled>
</releases>
<snapshots>
<enabled>false</enabled>
</snapshots>
</pluginRepository>
</pluginRepositories>

</profile>
2. TEmirrorsTssarpiEN:
<mirror>

<id>huaweicloud</id>

<mirrorOf>* !HuaweiCloudSDK</mirrorOf>

<url>https://repo.huaweicloud.com/repository/maven/</url>
</mirror>

3. t&hNactiveProfilestr& g EHCE :
<activeProfiles>
<activeProfile>MyProfile</activeProfile>
</activeProfiles>

Eclipse NECE ST
SNTRHIIRE

1 FTFFEclipse, 7ESEERFZIERRE “File > Import” , 38 “Import” SHFEHE, HEIF
“General > Existing Projects into Workspace” , 1%&#Z##/EEHY “ APIGW-java-sdk-
xxx” Ik,

SZAERRAN 01 (2024-02-18) WRIERE © HERRARBIRAT 14



APl B2 155 3 AK/SK BEZINHEFIES

3-5 Import

& import o e
Create new projects from an archive file or directory. H

Select an import wizard:

type filter text

4 [= General
& Archive File
=2 Existing Projects into Workspace
[} File System
] Preferences
[} Projects from Folder or Archive

3-6 Import Projects

& Import = |- eES]
Import Projects — B
i .-.Il
Select a directory to search for existing Eclipse projects. / “f

@ Select root directory:  EA\1903-APIG-dema\ApiGateway-sdk0 ~

71 Select archive file: Browse...

Projects:

-dema‘\ApiGateway-sdk01\ApiGateway-sdK\APIGW-java-sdk-3.0.9) ’ Select All ]

Deselect All

£B;2 BE “Finish” , TSN, SAGERIREIREN TR,

STRERA 01 (2024-02-18) IRIFTS © ERRABRAT 15
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3-7 EE2RHITE
i@ workspace - Eclipse IDE
File Edit Mawvigate Search Project Run Window Help

B-BR®-i8iv]

5 Project Explorer &2 = _l>| e =~ — O

4524 java-sdk-demo:

» B, JRE System Library [JAVA]
4 (B src
4 1 com.apig.sdikedemo
- 1] Mainjava
4 ), Referenced Libraries
» s commaons-codec-1.11,jar
» s commons-logging-1.2.jar

o hitpelient-4.5.5,ar

|0

» [y httpcore-4.4.9.jar

4 java-sdk-core-3.0.9.jar

|0

> fong jnda-time-E.El.El._iar

.
(10 #488
LI T Eclipse, IDKIME—RREERENF, XEARHIRHE,
SR TREHIINEHSDK

ZB1 FJFFEclipse, FhiE—Java Project, BEX “Project name”
demo” Jfl, EfthSHIRIFEAIA, BE “Finish”

, LL “java-sdk-

kR 01 (2024-02-18) WRIERE © HERRARBIRAT
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&} New Java Project

Create a Java Project

Create a Java project in the workspace or in an external location.

Lo 5] ]

Project name: java-sdk-demo

Use default location

(7 Use default JRE (currently 'jre1.8.0_102

Project layout

(") Use project folder as root for sources and class files

Working sets

[[] Add project to working sets

F\workspace\java\java-sdk-demo Browse...
JRE
@ Use an execution environment JRE: JavaSE-1.8 -
7 Use a project specific JRE: jrel.8.0_102

Configure JREs...

@ Create separate folders for sources and class files Configure default...

Select..

@' [ = Back H MNext = l [ Finish

|| cancel

£ S ANJava SDKHY “jar” &,

1. AEBEHENTRE “java-sdk-demo” , ##% “Build Path > Add External

Archives”

kR 01 (2024-02-18) WRIERE © HERRARBIRAT
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A|bJ java-selle-damal

» @ JR
& s

X Er Y

C- &

%

New

Go Into

Open in New Window
Open Type Hierarchy
Show In

Show in Local Terminal

Copy
Copy Qualified Name

Paste

Delete

Remaove from Context
Build Path
Source

Refactor

Import..
Export.

Refresh
Close Project
Clase Unrelated Projects

Assign Working Sets...

F4
Alt+Shift+W »
»

Ctrl+C

Ctrl+V
Delete

Ctrl +Alt+Shift+Down
»

Alt+Shift+S »
Alt+Shift+T »

Fs

Link Source...

New Source Folder...

Use as Source Folder

Add External Archives...

Add Libraries...

Configure Build Path...

2. I&EESDKH “javallibs” BRTEBIL “jar” LSRRI,

\%| commons-codec-1.6,jar 2018/2/11 946 Executable Jar File 228 KB |
|%| commens-logging-1.1.3 jar 2018/2/11 9:47 Executable Jar File 61 KB|
| %] httpclient-4.3.6,jar 2017/12/8 9:28 Executable Jar File 579 KB |
|| httpcore-4.3.3 jar 2018/2/11 2:45 Executable Jar File 277 KB|
|| java-sdk-core jar 2018/2/12 17:34 Executable Jar File 115 KB |
| %] joda-time-2.7 jar 2017/12/8 9:28 Executable Jar File 576 KB |

3. BFE “4TH7 , SRSDK5IAN,
I3 F{E “Package” & “Main” {4,

1. AEEEE “src” , 1%&IE “New > Package” .

a =% APIG-Demo

I mih JRE System Library [JavaSE-1.8]

|28 5=

New

Open in New Window

Open Type Hierarchy
Show In

Gl e ]

2. 7 “Name” #ig\ “com.apig.sdk.demo” ,

=
]
F4 |8

Alt+Shift+ W » | &
v

Java Project

Project...

Package

Class

ey

SASPRZAS 01 (2024-02-18)
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s

i@ New Java Package = @

Java Package
Create a new Java package.

Creates folders corresponding to packages.

Source folder: java-sdk-demaoyfsrc
MName: com.apig.sdk.demo|

[ Create package-info,java

?\ Finish ] ’ Cancel

3. B “Finish” .
Fehk “Package” BIBUE.
4. HAEREE “com.apig.sdk.demo” , #E#E “New > Class” ,

a 15 Other Projects
4 12 APIG-Demo
> i JRE System Library [JavaSE-1.8]

4 (3 src
3 com.apig.sdk.dema
New v | 2% Java Project
Open in New Window ] | Bries=
Open Type Hierarchy F4 | f#f Package
Show In Alt+Shift+W r | G Class
Show in Local Terminal v | Interface
(=R redor | & Enum
5. £ “Name” fhigi\ “Main” , @i% “public static void main(String[]
args)” o

STRERA 01 (2024-02-18) IRIFTS © ERRABRAT 19
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& New Java Class ?@

Java Class =
Create a new Java class. \;)

Source folder: java-sdk-demo/src
Package: com.apig.sdk.demo
[7] Enclosing type: Browse...

MName: Mainl

Madifiers: @ public ) package private protected

[]abstract [|final static
Superclass: java.lang.Object
Interfaces: Add...

Remave
Which method stubs would LIS likce to create?
public static void main(String[] args)
[] Constructors from superclass
[¥] Inherited abstract methods
Do you want to add comments? (Configure templates and default value here
|:| Generate comments
A .
'\?,' Finish l [ Cancel

6. B “Finish” ,
R “Main” THRVBIEE
$]4A TR IIRCIE.
“Mainjava” TiEEEFER, BIREXRERSEAPHERMAMELE.
----455R

API EFH

B IRESOARMEEE U EREA . LUFLAREIRAG, N BUEEERIN
i ASDKIEITIERES .

1 fEMainjavadFIIALL TSI,

import java.io.|OException;
import javax.net.ssl.SSLContext;

import org.apache.http.Header;

import org.apache.http.HttpEntity;

import org.apache.http.HttpResponse;

import org.apache.http.client. methods.HttpRequestBase;

STRERRA 01 (2024-02-18) IREUE © ERREARBIRAS 30
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import org.apache.http.conn.ssl. AllowAllHostnameVerifier;
import org.apache.http.conn.ssl.SSLConnectionSocketFactory;
import org.apache.http.conn.ssl.SSLContexts;

import org.apache.http.conn.ssl. TrustSelfSignedStrategy;
import org.apache.http.impl.client.CloseableHttpClient;
import org.apache.http.impl.client.HttpClients;

import org.apache.http.util.EntityUtils;

import com.cloud.apigateway.sdk.utils.Client;
import com.cloud.apigateway.sdk.utils.Request;

flirequest, HSERURSSHFBINEXEH:
REBICABATRARATT

Request request = new Request();
try {
//Set the AK/SK to sign and authenticate the request.
// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.
// In this example, the AK/SK are stored in environment variables for identity authentication. Before
running this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.

request.setKey(System.getenv (" HUAWEICLOUD_SDK AK"));
request.setSecret(System.getenv(" HUAWEICLOUD_SDK SK"));

//The following example shows how to set the request URL and parameters to query a VPC list.

//Specify a request method, such as GET, PUT, POST, DELETE, HEAD, and PATCH.
request.setMethod (" GET");

//Set a request URL in the format of https://{Endpoint}/{URI}.
request.setUrl(" https.//endpoint.example.com/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs?
limit=2"),

//Set parameters for the request URL.
request.addQueryStringParam("limit", " 2");

//Add header parameters, for example, Content-Type application/json.

request.addHeader (" Content-Type", "application/json");

//Add a body if you have specified the PUT or POST method. Special characters, such as the double
quotation mark ("), contained in the body must be escaped.

//request.setBody(" demo");

//setBody R 7 #Fstring2$EY

} catch (Exception e) {
e.printStackTrace();

return;
}
XHERIFITER . IHIEAPIFFTENLE
HFEBENT
CloseableHttpClient client = null;
try
{

HttpRequestBase signedRequest = Client.sign(request);

client = HttpClients.custom().build();
HttpResponse response = client.execute(signedRequest);
System.out.println(response.getStatusLine().toString());
Header[] resHeaders = response.getAllHeaders();
for (Header h : resHeaders)
{

System.out.printin(h.getName() + ":" + h.getValue());
}
HttpEntity resEntity = response.getEntity();
if (resEntity != null)

SRS 01 (2024-02-18) IS © ERRAGIRAT 71



AP| £&Z15r

3 AK/SK EZINIBREES:

{

System.out.println(System.getProperty("line.separator") + EntityUtils.toString(resEntity, "UTF-8"));

}

} catch (Exception e)

{
e.printStackTrace();
} finally

{
try

if (client != null)

client.close();

}
} catch (IOException e)

{

}
}

e.printStackTrace();

A AEERED “Mainjava” , 1%#E “Run As > Java Application” .

$IB5 £ “Console”

BT TRENEAE.

[% Package Explorer 2 = =
4 [ java-sdk-demo
4 [ src
4 i com.apig.sdk.demo
a m Mgim fmem
P (;b New
Open
> @i JRE Systel Open With

> @ Reference Open Type Hierarchy

Show In

Copy
Copy Qualified Name

B

Paste
¥ Delete

Remove from Context
Build Path
Source

Refactor

E

Import...
Export...

References

Declarations

" Refresh
Assign Working Sets...

Run As
Debug As
Profile As
Validate

Team

e e AAESL

nE, BEAETER.

F3
»
F4

Ale+Shife+W »

Ctrl+C

Crl+V
Delete

Ctrl+Alt+Shift+ Down

3

Ale+Shift+S »
Ale+Shift+T »

display at this time.

D% 1 Run on Server

0 2 Java Application

B Console &2 7

Alt+Shift+X, R
Alt+Shift+X, J

Run Configurations...

N5k 01 (2024-02-18)
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[# Package Explorer &2 = 8
B & ¥
4 [ java-sdk-demo
4 (B src
4 f}f com.apig.sdk.demo
> |[J] Mainjava

> @ JRE System Library [JavaSE-1.8]

. m) Referenced Libraries

B Console 52 .7

=terminated= Main (2) [Java Application] D:\02.Tool\Java\jdk1.8.0_144\bin\javaw.exe (Z
HTTP/1.1 288 0K

Date:Thu, 28 Dec 2817 @7:29:43 GMT
Content-Type:text/html; charset=UTF-8
Transfer-Enceding: chunked
Connection:keep-alive
X-Request-Id:ael776d9283d98ce3eedledcalelcdal
Server:api-gateway

demo

R

3.6.2 Go

AT LAntelli) IDEATEAAI, NBINEIEGoMIEHERMAPIEREZHISDK, ZaTlA
BEIZSNRAI TR, ARESEARIRPISBEZSDKEREIZIIM AT,
£ IDEA FFEIFE
o FRENFHZZEIntelli) IDEA, AJEIntelli) IDEAE ML
o FREHZREGoZEE, JEGOE T FERMHE M.
o TEIDEARRZLEGolEY, 1BFIFF “File > Settings” , SITEFIR.

3-8 IDEA &% Go 1@E

Settings
Q- Plugins Marketplace 2 Installed Updates
A rance & Behavior
Ppea Q- gol 3
Keymap
Search Results (190)
Editor
BT - - Go Template
Version Control B Languages Languages
Build, Execution, Deployment This plugin extends Intelli) Suppeort for Go ten
Languages & Frameworks clatl"v:’m -.';i-_l‘ Go-specific EI"EJiI“E”
coding assistance and tool (https://golang.org
Tools —B nE 2010 4 T4 T

$%HY SDK
st FESDKSDemo
RIEREE S FREN RIS DKAAS R~ AT & o
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core\escape.go 1R RIE N

core\signer.go FHZSDK

demo.go ~ECHS
IDEA Ti2HSNTHI

1 FTFFIDEA, HEIFZEE “File > New > Project” .
58 “New Project” STIEIE, & “Go” , BFE “Next” .

Mew Project

Java
Java Enterprise

'; JBoss

il J2mE

M Clouds
Spring
Java FX
Android
Intelli) Platform Plugin

@ Spring Initializr
Mawven

Gradle

& Groovy
Grails

Application Forge

© Go Modules (vgo)

2 B “7 , ERHAOXNEIESIEIREESRISDKERR, B&E “Finish” |

= Go 1121
Index entire GOPATH

Additional Libraries and Frameworks:

[ 1+ Python
[ aa: SQL Support

NH5hRZA 01 (2024-02-18)
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Bl New Project

Project name: APIGW-go-sdk-2.0.0

Project location: | EAApiDemodAPIGW-go-sdk-2.0.0

$I]3 TRIECEE, BREMUT,

Bl apigw-go - [E:\ApiDemo\APIGW-go-sdk-2.0.0] - Intelli) IDEA 2016.2.3
File Edit View Mavigate Code Analyze Refactor Build Run Tools VCS

' APIGW-go-sdk-2.0.0 |
G- Project "7 I I g

v B APIGW-go-sdk-2.0.0 E:\ApiDemo\APIGW-go-sdk-2.0.0
[ .idea
[ core

i
escape.go

m 1 Project |

" signer.go
[ licenses
[& APIGW-go-sdk-2.0.0.iml
" demo.go
il External Libraries

II 1 Structure

R

iBkEZ5 APIEA
$£B1 EITRE$5| Asdk (signer.go) -

import "./core"

2 HER—1N#rA9Signer, S BIBINAKFISKIE
s := core.Signer{
// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.
// In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.
Key: os.Getenv("HUAWEICLOUD_SDK_AK"),
Secret: os.Getenv("HUAWEICLOUD_SDK_SK"),

STRERA 01 (2024-02-18) IRIFTS © ERRABRAT 75
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B3 E— 1 FORequest, IEEEZ . FHixE. iB5Kurlflbody.,

//The following example shows how to set the request URL and parameters to query a VPC list.
//Add a body if you have specified the PUT or POST method. Special characters, such as the double

quotation mark ("), contained in the body must be escaped.

r, _ = http.NewRequest("GET", "https://service.region.example.com/v1/{project_id}/vpcs?a=1",

ioutil. NopCloser(bytes.NewBuffer([]byte(""))))

$RA TINFESZREML, SEEMARAISE, WMSMEHRFRINX-Project-Id,

& 2BIRFBHEHIRI0X-Domain-Id

/Add header parameters, for example, X-Domain-Id for invoking a global service and X-Project-Id for

invoking a project-level service.
r.Header.Add("X-Project-Id", "xxx")

ZB5 HITER, HITRHBSEERFPFIIBATFERZRIX-Sdk-DateskF1Authorizationsk .

s.Sign(r)

$186 HEAPI, BEIHOLEE,

resp, err := http.DefaultClient.Do(r)
body, err := ioutil.ReadAll(resp.Body)

TS
3.6.3 Python

A LAntelli) IDEATEAAI, uf”lll]ﬂY_PythonHiEEFIEﬁJzAPIua'ﬁ T 2HYSDK, &
ALEZESANTOIIERE, AESERBIRIPESBEEESDKEREIZIINAF .

HEEIR
o FRENFHZ%EIntelli) IDEA, TBIZEIntelli) IDEAEH ML & .

o RENFZEPythonZ3 B ( BI{FHE2.7.9+53X, B88279) ,
TEIR®E FE

PythonZ3E5ERkfa, Eam<SiTHERpipZEE “requests” JE.

pip install requests

AIZEPythonE7

Marketplace 2 Instal

MicroPython

Framework i

AR
R pipZierequestsiBEREREIR, 1B FEFHERPythondTHIE, ALkpip, AEE
PATLA LSRR,
o TEIDEARRZIEPythoniff4, W TEFIT.
Settings
Q- Plugins
Appearance & Behavior Q- python 3
Keymap
. Search Results (41)
Editor
L Plgins [
Version Control I Languages
Build, Execution, Deployment The Python plug-in provides

Languages & Frameworks smart editing for Python
scripts. The feature set of the
Tools e o e i
H 26, 2019 2.5M tr39

Support for I
devices in Int
PyCharm. Fea

kR 01 (2024-02-18) WRIERE © HERRARBIRAT

26


https://www.jetbrains.com/idea/
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$XEX SDK
st TESDKSDemo,
REEEREMRNT:

LR 1588
apig_sdk\__init__.py SDK{{HS
apig_sdk\signer.py

main.py ~HIHS

licenses\license-requests

FE=FFlicense3 {4

THTRESAN
FIB1 FTFFIDEA, EIRFEE “File > New > Project” o

s “New Project” XHiEIE, 1#%&1F “Python”

New Project (=)

o
Gralls Project SDK: Python 3.7 (Python 3.7.2) ~ New...
Application Forge Additional Libraries and Frameworks:

9 Go [1EJf] Diango

9 Go Modules (vgo) 1€ Google App Engine (Python)

% Dep [ 5QL Support

5 App Engine
Static Web

(2 Nodejs and NPM

E Flash

aa PHP Template language:

K Kotlin Templates folder: templates
Empty Project Enable Django admin

Mext Cancel Help

£ BREE “Next” , BHELITXHEE. 8F “..

SDKE&2, B “Finish” .

MNew Project
Project name: | APIGW-python-sdk-2.0.1

Project location: | EA\ApiDemao\APIGW-python-sdk-2.0.1

$E5 “ Next” .

7, R ERIRHEE IR EERY

NH5hRZA 01 (2024-02-18)
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e TiECEfE, BREWUT.

APIGW-python-sdk-2.0.1 [EA\ApiDemao\APIGW-python-sdk-2.0.1] -
File Edit View Mavigate Code Analyze Refactor Build Run

APIGW-python-sdk-2.0.1 main.py

Project + B - o — ma

APIGW-python-sdk-2.0.1
> Jidea
» apig_sdk

I 1 Project |
{

b licenses
n APIGW-python-sdk-2.0.Liml
main.py
test_signer.py
¥ External Libraries

Scratches and Consoles

et

iERERS APIER

SER1

£HR2

H$EE3

+R4

$IE5

Ean 1T, EMpipZEE “requests” F,

pip install requests

EIfEH5| Napig_sdk,

from apig_sdk import signer
import requests

HR— A EHISigner, BAAKFISK,

sig = signer.Signer()

# Set the AK/SK to sign and authenticate the request.

# Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.

# In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.

sig.Key = os.getenv('HUAWEICLOUD_SDK_AK")

sig.Secret = os.getenv('HUAWEICLOUD_SDK_SK')

H£r— 1 #A9Request, FEEEHSZ . HiER . iB3Kurifdbody,
VAEHIFAB =IRSBHIEIIVPCHIRIE O MBI, HTTPFSIEAGET, 1% ( Endpoint) /9

service.region.example.com, 53K
URI: /v1/77b6ad4cba5143ab91d13ab9a8ff44fd/vpcs?limit=1

# The following example shows how to set the request URL and parameters to query a VPC list.
r = signer.HttpRequest("GET", "https://
{service}.region.example.com/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs?limit=1")

# rbody = "{\"a\":1}"

AINFBEZANERBEEL, EEMARLEY, WNBHE7H=HFRI0X-Project-
Id, SEEBIRSH=FIRIIX-Domain-Id, WRFNISMEKREEL, EREES
payl R

r.headers = {"X-Project-Id": "xxx"
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6 HITER, BITHRHESEBERSHPIRINATFERZAIK-Sdk-DateskFNAuthorization
sig.Sign(r)
(1] #eA
o X-Sdk-Date2— MM EEZBERBEELSH .
o IBEZXIMLBEELSHSE5TER, HSDKEITTK.
FIE7 HIAPI, BEEIHITER,
resp = requests.request(r.method, rscheme + "://" + rhost + r.uri, headers=r.headers, data=r.body)

print(resp.status_code, resp.reason)
print(resp.content)

R
3.6.4 C#
AFLAVisual Studio TEFH, NBIMTECHIMEFREMAPIERZEZRISDK, EAILL
BEEENRAIRERR, AESERABIREISPDEEASDKEMEIERINAF,
ESEE
SRENFH 222t Visual Studio, BJZEVisual StudioE 75 ML &k .
$KEX SDK
it FESDKSDemo,
RIEEEREMWNT:
2R 2k
apigateway-signature\Signer.cs SDK{LAS
apigateway-signature\HttpEncoder.cs
sdk-request\Program.cs BRIBERREIKS
csharp.sin TR
licenses\license-referencesource E=FElicense3 {4
FIFIRE
WHESDKEHRY “csharpsin” 324, $FTHIFE. He, apigateway-signatureliB /9
M FEEHZE, aTAF Net Framework5.Net CoreliH ., “sdk-request”
IR B #iREBRE.
15R&EZ5 APIER

£ EIEPSIAsdk,

using System;
using System.Net;
using System.IO;
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£1R6

using System.Net.Http;
using System.Threading;
using APIGATEWAY_SDK;

HR— A ERISigner, EEANAKFISK,

Signer signer = new Signer();

// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.

// In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.

signer.Key = Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_AK");

signer.Secret = Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_SK");

SR —#RIRequest, IEEEE . FiES . iB5Kuriflbody.

//The following example shows how to set the request URL and parameters to query a VPC list.
HttpRequest r = new HttpRequest("GET", new Uri("https://
{service}.region.example.com/v1/77b6ad4cba5**********Qa8ffA4fd /vpcs?limit=1"));

//Add a body if you have specified the PUT or POST method. Special characters, such as the double
quotation mark ("), contained in the body must be escaped.

rbody =""

)= EK%E'JHWJ—ALH I EHEHMARILE, MBIREHSHIRIMX-Project-Id,
:E%@E’HE%%R 1/J\\7]|]X'D0ma|n Id,

//Add header parameters, for example, X-Domain-Id for invoking a global service and X-Project-Id for
invoking a project-level service.
r.headers.Add("X-Project-1d", "xxx");

WITER, PITIRBEER— N FHIHttpWebRequest, FEBSRKSEHPRMATE
BZHIX-Sdk-DateskFAuthorizationsk,

INREEAHTTP Client, RILAMIBRAPIREGLEMSRER . XTLEER, B5F
AK/SKEZINIEREFE -

HttpWebRequest req = signer.Sign(r);

ILIEIAPI, BEFGIEER.

try

{
var writer = new StreamWriter(req.GetRequestStream());
writer.Write(r.body);
writer.Flush();
HttpWebResponse resp = (HttpWebResponse)req.GetResponse();
var reader = new StreamReader(resp.GetResponseStream());
Console.WriteLine(reader.ReadToEnd());

}

catch (WebException e)

{
HttpWebResponse resp = (HttpWebResponse)e.Response;
if (resp != null)
{

Console.WriteLine((int)resp.StatusCode + " " + resp.StatusDescription);
var reader = new StreamReader(resp.GetResponseStream());
Console.WriteLine(reader.ReadToEnd());

}
else
Console.WriteLine(e.Message);
}
}
Console.WriteLine("---------------- ");
5

3.6.5 JavaScript

AF5LAntelli) IDEATE R, NEUMTE)sHFEHERAPIEREZHISDK, EHaILAE
ESNTRH TS, ,H\Fﬁ%ﬂﬂmwﬂ*ﬂ MEE 2 SDKEREIZRIN A,
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LUE#EN ode jsH AR ME R BIT4R)avaScripthISDKEERL .

EFEE
o FKENFFZEIntelli) IDEA, AJEIntelli) IDEABS ML T3
o RENHZEENodejszit),, nJENodejsES FERME o
NodelsZifg, EHSTH, AnpmZiE “moment” 1 “moment-timezone”

&R,
npm install moment --save
npm install moment-timezone --save

o TEIDEAFZZEENoOdejsiEfE, A TEMT.

Settings
Q- Plugins Marketplace 2 Installed Updates
ippearan:e & Behavior Qv nodejs 3
eymap ’ o
Editor Search Results (4)
BN vodes NPM Script Runner
Version Control e M@t
Build, Execution, Deployment Support for Node,js projects. Nodejs package,json sc
Languages & Frameworks :Ea'_LII'Ef: :\LII".“JCdE.jS - runner.
applications from the IDE and A —E 9m 91T b 12
Tools C—F 11,2019 L6M 4.2 B
4
¥XEY SDK
MLt T SDK5SDemo,
BEEERETISIIN L, BEREREWNT:
B itz
signer.js SDK{LHES
node_demo.js Nodejs7 =Bt
test.js MBI
licenses\license-crypto-js FE=FElicenseX {4
licenses\license-node

BIETHE

$1 FTFFIDEA, EiRZEE “File > New > Project” .
s “New Project” XIEHE, E#FE “Static Web” , B “Next” ,
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-

B HTMLS Boilerplate

S Groovy
. ¥ Web Starter Kit
) Griffon & arer ™
, & React App
Grails

Foundation
Application Forge a
Ed Twitter Boatstrap
Y Angular)s
¥
& Dep Y Angular CLI

(2 Node.js and NPM

¥ Go

Web modules are used for developing Web applications using technologies
F Flash such as HTML/CSS, JavaScript, PHP and so on. They do not support
developing Java applications.

K kotlin

@ Python

Coneel || b

MNew Project @

5 Gradle

$|2 BE .7, EREAHEERIEEMEERRISDKERR, 2dE “Finish” .

Mew Praject

Project name: | APIGW-javascript-sdk-2.0.0

Project location:  E:\ApiDemc\APIGW-javascript-sdk-2.0.0

b More Settings

Previous Cancel

$I3 R ITRCEE, BREWUT.

Help
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Project B - o —
v [y APIGW-javascript-sdk-2.0.0 £\ ApiDemo\ APIGIN-)

> idea

b licenses

w APIGW-javascript-sdk-2.0.0.iml
3 node_dema.js
srpackage-lockjson
5 signers
5 testjs
¥ |l External Libraries

o Scratches and Consoles

#0124 EIDEABOA LS, 8F “Edit Configurations” & “Add Configurations”

Edit Configurations...

5 BE ‘47, &E “Nodejs” o

Run/Debug Configurations

* »
Add New Configuration

 Gruntjs

¥ Gulpjs

| JAR Application
[55 JavaScript Debug
;ﬂ lest

AF JUnit

i Jupyter Moteboolk
K Kotlin

K Kotlin script

) Lettuce

1 Maven

) Mocha

(5] Nodeunit

186  “JavaScript file” % “node_demo.js” , B “OK” , SERkECE.
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Run/Debug Configurations @
+ — B W » Name: node_demojs [ share []Allow parallel run
~ (5 Node.js . . . :

. Canfiguration Browser [ Live Edit V& Profiling Logs
(Enode_dema.js
> JTemplates MNode interpreter: C:\Program Files\nodejs\node.exe 10.15.3 ~

Node parameters:

Working directory: E\ApiDema\APIGW-javascript-sdk-2.0.0

JavaScript file: node_demo.js|

Application parameters:

Environment variables:

¥ Before launch: Activate tool window

35

(7] Cancel Apply
BT

APl AR ( Node.js )

SB1 EH5S1TH, Hnpm%zE “moment” 1 “moment-timezone” &1k,

npm install moment --save
npm install moment-timezone --save

LTE2 TEIREFS|Asignerjs,

var signer = require('./signer')
var http = require('http')

I3 Epi— 1 FrAYSigner, BN “Key” #0 “Secret” .

var sig = new signer.Signer()

// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.

// In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.

sig.Key = process.env.HUAWEICLOUD_SDK_AK

sig.Secret = process.env.HUAWEICLOUD_SDK_SK

FWA LR— P #HIRequest, IEEHZ . 5iEA. iBKuriflbody
//The following example shows how to set the request URL and parameters to query a VPC list.

var r = new signer.HttpRequest("GET",
"service.region.example.com/v1/77b6a44cba5143ab91d13ab9a8ff44fd/vpcs?limie=1");

//Add a body if you have specified the PUT or POST method. Special characters, such as the double
quotation mark ("), contained in the body must be escaped.
rbody =";

TS MIFTESKAVEMSLS, SEEMBIERkE, BB H=FRI0X-Project-1d,
o & 2 BRFBH=HIRI0X-Domain-Id

//Add header parameters, for example, X-Domain-Id for invoking a global service and X-Project-Id for
invoking a project-level service.
rheaders = {"X-Project-1d": "xxx"};

6 HITER, HITIHRHMESEMIBKRSE, BTFEI@EhttpsiEX, BRSHEFTHFINTHETF
L2 R9X-Sdk-DatesLFJAuthorizationsk

SRS 01 (2024-02-18) IS © ERRAGIRAT 3



APl 2157 3 AK/SK BZINIHREIES

var opt = sig.Sign(r)

ST HIAPI, BEEIBIOER.
var req = https.request(opt, function(res){
console.log(res.statusCode)
res.on("data", function(chunk){
console.log(chunk.toString())
b
bl
reg.on("error",function(err){
console.log(err.message)

bl
req.write(r.body)
reqg.end()

-

3.6.6 PHP

AT Antelli) IDEATE R, N BINTEPHPIFMERERMAPIEREZHISDK, EaTLL
BESANTHTIEARR, AESEARRPIESIESEZSDKERIIEHINAES,

EEE
o JRENFFZHIntelli) IDEA, AJZEIntelli) IDEAE SIS FE
o REVFFZREPHPZIKE, AJEPHPET; FEINHE Mo
o JEPHPZERZFHRY “php.ini-production” ZHEEHIF “C:\windows” , H&ZAH
“php.ini” , FEXHPIBINNTRS
extension_dir = " {phpZ R} ext"

extension=openssl
extension=curl

o TEIDEARRZEEPHPIEMH, WTEFAR,

Settings
Q- Plugins Marketplace 2 Installed Updates
A & Behavi
Ppearance enavior D\' php| 3
Keymap
Editor Search Results (129)
| Pugine SR PHP Annotations
Version Control Languages Framework integratic
Build, Execution, Deployment PHP 5.3-7.3 editing and PHP Annotation GitHutk
Languages & Frameworks debugging, PHPUnit, Smarty, I s | Donate Install:
Twig and various frameworks Just install and be hap
s G —F 08,2019 1 19M 3.5 s
4
SXEX SDK
Ht F#ESDKSDemo,
IR R =8 , BIERBERE :
REREIRBRETI SRk, BEEEREENT:
BR 1588
signer.php SDK{LAS

SRS 01 (2024-02-18) RIS © ERRAGIRAT 3


https://www.jetbrains.com/idea/
https://windows.php.net/download/
https://obs.cn-north-1.myhuaweicloud.com/apig-sdk/APIGW-php-sdk.zip

AP| £&Z15r

3 AK/SK BZINIEREIES

BIETE

index.php ~ECES

FIB1 FTFFIDEA, EIFZEE “File > New > Project” .

New Project

® Spring Initializr
Maven
% Gradle
S Groowy
) Griffon
Grails

Application Forge
= Scala

PHP
K Kotlin

& Go
¥ Dep

S8 “New Project” XJIEHE, & “php” , B&EF “Next” .

1) PHP Empty Project

@ Composer Project

Create empty project for PHP

$|2 BE 7, ERRAHEERIEEMEERRISDKERER, BdE “Finish” .

Mew Project

Project name: |APIGW-php-sd|-c-2.D.D| |

Project location: | EA\ApiDemo\APIGW-php-sdk-2.0.0

b More Settings

Previous Cancel Help

$]3 e iztlEfR, BREWUT.
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APIGW-php-sdk-2.0.0

g Project = B = 0o —
21~ g APIGW-php-sdk-2.0.0
= > Jidea
| .
m APIGW-php-sdk-2.0.0.iml
pe index.php

mn Signer.php
> External Libraries

Scratches and Consoles

-

iERERS APIER

gz

$4E3

L4

EALEBFSIAsdko

require 'signer.php’;

HER— N HREISigner, IEANAKFISK,

$signer = new Signer();

// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.

// In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.
$signer->Key = getenv('HUAWEICLOUD_SDK_AK'");

$signer->Secret = getenv('HUAWEICLOUD_SDK_SK');

HEp— 1 #HIRequest, FEEEHSZ . F5iEA . 1BKurifbody .

//The following example shows how to set the request URL and parameters to query a VPC list.
$req = new Request('GET', 'https://service.region.example.com/v1/{project_id}/vpcs?limit=1");

//Add a body if you have specified the PUT or POST method. Special characters, such as the double
quotation mark ("), contained in the body must be escaped.

$reg->body ="

DB EXZNIE ML, siEEMMRERROkE, WSMBHSEFIFINX-Project-Id,
D& 2 BRFZHS=HIRI0X-Domain-Id,

//Add header parameters, for example, X-Domain-Id for invoking a global service and X-Project-Id for
invoking a project-level service.
$req->headers = array(
'X-Project-Id' => 'xxx',
)
HITEE, MITHRBSER— 1 Scurl L FXEE,
$curl = $signer->Sign($req);
IBIEIAPI, BFIBIAER.
$response = curl_exec($curl);
echo curl_getinfo($curl, CURLINFO_HTTP_CODE);

echo $response;
curl_close($curl);

R
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3.6.7 C++

ERIRE
PALinux UbuntuR&F A6, BEFEELRRSSUHEXIER,

1. Z&opensslE,
apt-get install libssl-dev

2. ZTEcurlE,

apt-get install libcurl4-openssl-dev

$REY SDK

mt F#ESDKSDemo,

RRIERNEERERISIN X, BEREREENT:
BHR AR
hasher.cpp SDK{t#g
hasher.h
header.h

RequestParams.cpp

RequestParams.h

signer.cpp

signer.h

constants.h

Makefile MakefileSZ{4

main.cpp ~ECES

BREZS APIEH
FIE1 fEmain.cppFIIANLATEIA.

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.n"

B2 Ap— P ETHYSigner, YSAK/SKSBIREN o

//Set the AK/SK to sign and authenticate the request.

// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.

// In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.

Signer signer(getenv("HUAWEICLOUD_SDK_AK"), getenv("HUAWEICLOUD_SDK_SK"));

B3 ER— 1 Fa9RequestParams, IEEFRER. & . iB5Kuri. BBZFFrEFbody,

SRS 01 (2024-02-18) RIS © ERRAGIRAT 3%


https://obs.cn-north-1.myhuaweicloud.com/apig-sdk/APIGW-cpp-sdk.zip

APl EZ18F

3 AK/SK BEZINIBREES:

//Specify a request method, such as GET, PUT, POST, DELETE, HEAD, and PATCH.

//Set a request URL.

//Set parameters for the request URL.

//Add a body if you have specified the PUT or POST method. Special characters, such as the double

quotation mark ("), contained in the body must be escaped.

RequestParams* request = new RequestParams("GET", "service.region.example.com",
"limit=2", "");

ANEBEERZAILE, SiEEMERLE, NZMBGSSIRI0X-Project-1d, &
EBIRSEH=FiRINX-Domain-Id,

//Add header parameters, for example, X-Domain-Id for invoking a global service and X-Project-Id for
invoking a project-level service.
request->addHeader("X-Project-1d", "xxx");

HITER, PUTIHERHSBERRIZELINArequestZEH .

signer.createSignature(request);

{EcurlZFE1BEIAPI, BFIBAER,

static size_t
WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)
{

size_t realsize = size * nmemb;

struct MemoryStruct *mem = (struct MemoryStruct *)userp;

N1/ {project_id}/vpcs",

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);
if (mem->memory == NULL) {

/* out of memory! */

printf("not enough memory (realloc returned NULL)\n");

return 0O;

}

memcpy (& (mem->memory[mem->size]), contents, realsize);
mem->size += realsize;
mem->memory[mem->size] = 0

return realsize;

}

//send http request using curl library
int perform_request(RequestParams* request)
{
CURL *curl;
CURLcode res;
struct MemoryStruct resp_header;
resp_header.memory = (char*)malloc(1);
resp_headersize = 0;
struct MemoryStruct resp_body;
resp_body.memory = (char*)malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, request->getMethod().c_str());

std::string url = "http://" + request->getHost() + request->getUri() + "?" + request->getQueryParams();

curl_easy_setopt(curl, CURLOPT_URL, url.c_str());

struct curl_slist *chunk = NULL;

std::set<Header>:iterator it;

for (auto header : *request->getHeaders()) {
std::string headerEntry = header.getKey() +
printf("%s\n", headerEntry.c_str());
chunk = curl_slist_append(chunk, headerEntry.c_str());

neon

+ header.getValue();

curl_easy._ setopt(curl CURLOPT HTTPHEADER, chunk);

curl_easy_setopt(curl, CURLOPT_COPYPOSTFIELDS, request->getPayload().c_str());
curl_easy_setopt(curl, CURLOPT_NOBODY, OL);

curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
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curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);
//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res !'= CURLE_OK) {
fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));
}
else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
printf(resp_body.memory);
}
free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);

curl_global_cleanup();

return 0;
}
F,T izfTmakemSRiE, BEIAHITEmain, HiTmainXE, BELER.,
.

368C

HERWRIE
PALinux UbuntuR St fl, BEHEELRSSLIEXT R,

1. ZZopensslZE.,
apt-get install libssl-dev

2. ZTEcurlE,

apt-get install libcurl4-openssl-dev

$XEY SDK
st TFESDKSDemo,
FRIERTICEIR R ER BN, BESEREWNT:

2R izl:lz
signer_common.c FZSDKItHE

signer_common.h

signer.c

signer.h

Makefile Makefile3Z {4
main.c IS
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BREZS APIER

g2y

S$IR3

Emain.cFIIANLL TS,

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.h"

HR— sig_params_tZERIRYTT S, EANAKFISK,

sig_params_t params;

sig_params_init(&params);

// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.

// In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.

sig_str_t ak = sig_str(getenv("HUAWEICLOUD_SDK_AK"));

sig_str_t sk = sig_str(getenv("HUAWEICLOUD_SDK_SK"));

params.key = ak;

params.secret = sk;

BEREZ. 3. BKkuri. EEFFEFMbody,
sig_str_t host = sig_str("service.region.example.com");
sig_str_t method = sig_str("GET");

sig_str_t uri = sig_str("/v1/{project_id}/vpcs");
sig_str_t query_str = sig_str("limit=2");

sig_str_t payload = sig_str("");

params.host = host;

params.method = method;

params.uri = uri;

params.query_str = query_sttr;

params.payload = payload;

NSk ES L, sEEMAIRALE, MBMBIHSSRINX-Project-Id, ELBIR
Eim=hiRINX-Domain-1d,

//Add header parameters, for example, X-Domain-Id for invoking a global service and X-Project-Id for
invoking a project-level service.
sig_headers_add(&params.headers, "X-Project-1d", "xxx");

HITESR, PUTIHRBSEERRIEZ LI requestiT £,

sig_sign(&params);

{FERcurlERIEIAPI, BFLIEIER.

static size_t
WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)
{

size_t realsize = size * nmemb;

struct MemoryStruct *mem = (struct MemoryStruct *)userp;

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);
if (mem->memory == NULL) {

/* out of memory! */

printf("not enough memory (realloc returned NULL)\n");

return 0O;

}

memcpy (& (mem->memory[mem->size]), contents, realsize);
mem->size += realsize;
mem->memory[mem->size] = 0

return realsize;

}

//send http request using curl library
int perform_request(RequestParams* request)

{
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CURL *curl;

CURLcode res;

struct MemoryStruct resp_header;
resp_header.memory = malloc(1);
resp_headersize = 0;

struct MemoryStruct resp_body;
resp_body.memory = malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, params.method.data);
char url[1024];
sig_snprintf(url, 1024, "http://%V%V?%\V", &params.host, &params.uri, &params.query_str);
curl_easy_setopt(curl, CURLOPT_URL, url);
struct curl_slist *chunk = NULL;
for (inti =0; i < params.headers.len; i++) {
char header[1024];
sig_snprintf(header, 1024, "%V: %V", &params.headers.data[i]l.name, &params.headers.data[i].value);
printf("%s\n", header);
chunk = curl_slist_append(chunk, header);
}
printf("------------- \n");
curl_easy_setopt(curl, CURLOPT_HTTPHEADER, chunk);
curl_easy_setopt(curl, CURLOPT_POSTFIELDS, params.payload.data);
curl_easy_setopt(curl, CURLOPT_NOBODY, OL);
curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);
//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res !'= CURLE_OK) {
fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));
}
else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
printf(resp_body.memory);
}
free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);

curl_global_cleanup();

//free signature params
sig_params_free(&params);

return O;
}
BT zfTmakedp$ iRz, BRIRTHITEHmain, HiTmainXd, BEER,

3.6.9 Android
AF5LAAndroid StudioTEAH, MNMBRUNEIFEAndroid MEAEERAPIEREZHAISDK,

EALAEES AR TERARY, AESEERBIRBERDIEESESOKEREIEIINF
H

EENIR
RENFH ZZEANdroid Studio, BJZAndroid StudioE 5 Mis & .
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3 AK/SK BZINIHREIES

¥REX SDK
Atk FESDKSDemo.
RIERBREWNT:
BHR 588
app\ ZE TR
build.gradle gradlefc &34

gradle.properties

settings.gradle

FIFIRE
$£81 #JFAndroid Studio, %#% “File > Open” ,
e A HEIE ISR R E S RISDKEER
B2 THAIER, BREGUT,

h app
b manifests
w Java
W com.testappsignature
£ MainActivity
> com.test.appsignature (androidTest)
> com.testappsignature (test)
v res
> drawable
v layout
v activity_main.xml
3 mipmap
> values

w (# Gradle Scripts

# build.gradle (Project: android)

# build.gradle (Module: app)
gradle.properties (Global Properties)
gradle-wrapper.properties (Gradle Version)

= proguard-rules.pro (ProGuard
gradle.properties (Project Properties)

# settings.gradle (Project Settings)

DK Location)

local.properties (S0

s
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APl EZ18F

3 AK/SK BEZINIBREES:

BREZS APIER

£

SER2

I3

L4

fEAndroid TF2RAY “app/libs” BRT, MASDKFrFEjarE. HAjarE84REiE:
e java-sdk-core-x.x.x.jar

e commons-logging-1.2.jar

e joda-time-2.9.9 jar

£ “build.gradle” 34NN\ okhttpERIIKES o

£ “build.gradle” 3744419 “dependencies” TN “implementation
'‘com.squareup.okhttp3:0khttp:3.11.0'” ,

dependencies {

implementation 'com.squareup.okhttp3:okhttp:3.11.0'
}

BlfErequest, MIAAKFISK, FHEEE®E . HiESA. . i&Kuriflbody,
Request request = new Request();
try {
// Directly writing AK/SK in code is risky. For security, encrypt your AK/SK and store them in the
configuration file or environment variables.
// In this example, the AK/SK are stored in environment variables for identity authentication. Before running
this example, set environment variables HUAWEICLOUD_SDK_AK and HUAWEICLOUD_SDK_SK.
request.setKey (System.geten/("HUAWEICLOUD_SDK_AK"));
request.setSecret(System.getenv("HUAWEICLOUD_SDK_SK"));
request.setMethod ("GET");
request.setUrl("https://service.region.example.com3/v1/{project_id}/vpcs");
request.addQueryStringParam("name", "value");
request.addHeader("Content-Type", "text/plain");
//request.setBody("demo");
} catch (Exception e) {
e.printStackTrace();
return;

}

MHERFITEE, H£Rokhttp3.RequestXTSRKiIHTIAPI,
okhttp3.Request signedRequest = Client.signOkhttp(request);

OkHttpClient client = new OkHttpClient.Builder().build();
Response response = client.newCall(signedRequest).execute();

-
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4 $EIRADIR A

HixtoiehA

LIFRZ=IRSAVAPIET, INERBR “APIGW” FFLAYFEIRG,

R FHITLIE

% 4-1 {Ei215

IFEEUTNENSHE

H=E | H\RER HTTP | iEX BHRG R
K&
i
APIGW. | The API does not exist | 404 APIREFEDR | i52%E"The API
0101 or has not been EMEIRE does not exist or
published in the has not been
environment. published in the
environment."{[
oI AR? Qb1
APIGW. | The API does not 404 APIEKRFEAR | RBAPIEKAGE
0101 exist. yees EREAPIENRY
FiEMEE
APIGW. | The backend does not | 404 TiEHE SR BEBATIF
0103 exist.
APIGW. | The plug-ins do not 400 | TiEENEMAED | BKREARSF
0104 exist. =1
APIGW. | The backend 400 | TiEHEIEIRED | BAERRARSZHF
0105 configurations do not =1
exist.
APIGW. | Orchestration error. 400 fmiEEIR KBEAPIEEAIET
0106 EiRsHEREE
APIGW. | API request error. 400 | BRBAAEE | FERAGIENEK
0201
APIGW. | Request entity too 413 iBkbodyid X R NMERKbody A/
0201 large. (KF12M)
XHhRAS 01 (2024-02-18) IRAERE © LA/ ARBIRAE 45
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4 $EIRADIR A

fEIRg B2 HTTP | iEX BRI R
K&
i}
APIGW. | Request URI too large. | 414 | i&RURIIZX R/ INERURIA /N
0201
APIGW. | Request headers too | 494 | i&skskigk B RSL AN
0201 large.
APIGW. | Backend unavailable. | 502 [EimAn] A BEAPIRBNG
0201 Imitei 2 A A
APIGW. | Backend timeout. 504 [EimiBaT N N ET B
0201 NSRBI BT 8]
APIGW. | Incorrect IAM 401 IAMINIEHEESE | IB2EIAMIAIEES
0301 authentication = Bz E
information.
APIGW. | The IAM user is not 403 IAMBRARF | ERRPEEHE/
0302 authorized to access 5Ia]API A2 ERE
the API.
APIGW. | Incorrect app 401 APPINIESESE | APPEZINIERT,
0303 authentication = MU TEE:
information. o HEERIT
&, BR. &8
S8, BRI
ERAFERNS
%, BRE. B8
2. BKIKE
B
o IEEFimilE
A8 =& E
B2EFEHAPPIA
IEEAAAPIIEES
ZLrBaYER,
APPCODEEZIA
UERY, fanTiE
B: KEBEKRES
s 7 X-Apig-
AppCodesLig;
APIGW. | The app is not 403 | APPASAIFIAIE | INEAPPEEIEN
0304 authorized to access API 15I1aJAPI
the API.
APIGW. | Incorrect 401 INIHEEEIR KMEANHEERS
0305 authentication 1FH#
information.
APIGW. | API access denied. 403 AAVFABBIAPI | BEEEIENAD
0306 API

MAERRAS 01 (2024-02-18)
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AP| E2Z35F

4 $EIRADIR A

=B | ERER HTTP | iEX BRI R
K&
i3
APIGW. | The token must be 401 TokenFEEEH | o FTFFMNIAMIRS
0307 updated. ¥%HYToken
o thBRBEEEH
T A [Eregioniy
0O, SEFER
FTokenskRL,
N EREO
URL
APIGW. | The throttling 429 | BERIRERS | o HFMIZRIFE
0308 threshold has been AEl. BAEY
reached. APIB¥®RZIH
1a]200)%
o =ARSFHIAY
AP, —iRFiE
BEEREN, 155
TR Eh
iaJ
o MGHEAPIRIXIR
el =FaellfE
APIl, WNFTEFE
PRER, BRI R
BEBATIF
APIGW. | The project is 403 projectA~BIfEEH | {EERAEEprojecti
0310 unavailable. ia]
APIGW. | Incorrect debugging 401 MRS | RERASIS
0311 authentication =
information.
APIGW. | Unknown client IP 403 TRRBERIR | BRERARSZE
0401 address. |PHBLE
APIGW. | The IP address is not | 403 IPHBUE AR FBIFIS | 1B IPHIIEE B
0402 authorized to access ia) B/B2ERF
the API.
APIGW. | Access to the backend | 403 FiwIPAFIFL | RimlPHEtslfSin
0404 IP address has been i3] 1A 3T R AY I PHbE
denied. AFFipaE, 15
BIPHI R EHE/
HRRRE, e
BN EIRIPES
==,
APIGW. | The app quota has 405 | APPEEBHIAT | T3SLAPPECAR
0501 been used up. 3
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AP| 1S 4 $EIRIBIRAA
=B | ERER HTTP | iEX BRI R
K&
it
APIGW. | The app has been 405 | APPH#RIGRES REAE, BaiE
0502 frozen. “REEE &
=8
APIGW. | Internal server error. 500 AEREEIR BRI
0601
APIGW. | Bad request. 400 | IEEIBXR KMEEKEEAR
0602
APIGW. | Domain name 500 | BRI mEREHS, L
0605 resolution failed. Mg B2 REHET
izl il
APIGW. | Failed to load the APl | 500 | RNNELAPIECE | BXERIEAS
0606 configurations.
APIGW. | The following protocol | 400 | MY A#EAIF, | BUASTIFAOINY
0607 is supported: {xxx} RN E (HTTP/HTTPS)
XXX 1508)
R oxASE
PRI AR S
sk
APIGW. | Failed to obtain the 500 TESRENEIEIE | BXEBATF
0608 admin token. =)
APIGW. | The VPC backend does | 500 | #FZlivpc/Fin | BFRBASIF
0609 not exist.
APIGW. | No backend available. | 502 REMEENE | KERERnER
0610 i aJH
APIGW. | The backend port 500 | EimiwORKE | BREREAE
0611 does not exist.
APIGW. | An API cannot call 500 | APIERBES 1ELZAPIfSimbeC
0612 itself. B, BERE
ReEEBIE10E
APIGW. | The IAM service is 503 IAMBRSZERIA | BARRARSIF
0613 currently unavailable. 1)
APIGW. | Backend signature 500 |itBEmREREX | BRERASE
0705 calculation failed. 5y
APIGW. | The service is 403 RS 1EXHE S EPTBITAYIRSS
0801 unavailable in the regionAaJifiE | @& XZiFiEregion
currently selected a1l
region.
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AP| E235F

4 $EIRADIR A

ERE | ERER HTTP | IBX BRI
g
APIGW. | The IAM user is 403 | ZIAMARFES | REEARFE
0802 forbidden in the Biregionmhifss
currently selected H
region.
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3k

ik
S
i
=

5.1 FInBizp= FEAEH API

ﬂﬂ%‘”E’JAET FIEY, BABE=RSAPIITHEERIEIN—MEKBELSEHX-Project-
SHEEFNIREID, 1BINSX-Project-IdiEXIRFIEE N EHZSDKSdemo,

5.2 APl FERE IFIKIER

APIMKSZHFIKIERE, (EERESER, BRORAASEIR,

5.3 Body ARAH LIS E5ER

SIEAEXBody#HITE B, BEHERLRILATSHMSHIE:
X-Sdk-Content-Sha256:UNSIGNED-PAYLOAD
wINZfE, Xdbodyit&hashHYERIEIIUNSIGNED-PAYLOAD,

IEKHEASHEAA LA SRR

WNRIGIZEBAK/SKEZINEERFREITRMAPIERER, 1&5FEX-Sdk-DatesmE
'5 g y = \1‘m1ﬁ—.}2 ﬁ E %”‘?ﬂ__ﬁ\_ o

IREERENTIREAISDKIITE R, WAFEZEPLBERERLSHSSE
#, SDKREEGEBITREMLESHSE5EER, HEMZAES .. WREMEKH
BASHREAEBREERERN, BmEBEENERE.

5.5 {(EAIIGET AK/SK (&3

INRERAIGITAK/SKINBERE S, BIGEZSDKEMEINERY, BEHELRMLITS
HrsHE:

X-Security-Token:{securityToken}
PARIERRIRBTAK/SKIFIBERIFITE R, EESDKSAK/SKAIEZSDK—EL,
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gz
SER2

BUE—API, ZRINEEFE “ELAAMINE" , FEH.

SREVY RIS RIIRRTAK/SKS {security Token}, {&5EIAMIZELSHY.
I RENRvE 2R

{

"credential": {
"access": "POHEQUQ4XBWXY5WD69X0",
"expires_at": "2022-10-17T18:51:25.231000Z",
"secret": "3WJu****hDVs",
"securitytoken": "XXXXXX......"
}
}

MISIER, HEEESH,

request.setKey ("POHE***69X0");
request.setSecret("3WJu****hDVs");

request.setMethod (" GET");

request.setUrl ("urt"');

request.addHeader ("X-Security-Token", "XXXXXX....." );

-

IAMINIHE2EEIR
e Incorrect IAM authentication information: verify aksk signature fail

e Incorrect IAM authentication information: AK access failed to reach the
limit, forbidden

e Incorrect IAM authentication information: decrypt token fail
e Incorrect IAM authentication information: Get secretKey failed

Incorrect IAM authentication information: verify aksk signature fail

gz

{
"error_msg": "Incorrect IAM authentication information: verify aksk signature fail, ......
"error_code": "APIGW.0301",
"request_id"; "FrRrRE

}

EIEEEES

BRINEEXEREER, ERHTENERERSAPINXIHTERNERERTE.
ERTE

LiE—: BEERE.
SREVAPIR 1T ERYcanonicalRequest,

MIREE(EEAIbodyHIREX “request_id” , @id “request_id” &fkshubaoTi =AY
error.log (errorlogfECLS &% ) , fEerrorlog#3kElcanonicalRequest,
2019/01/26 11:34:27 [error] 1211#0: *76 [lua] responses.lua:170: rewrite():
473a4370fbaf69e42f9da243eb8f8c52;app-1;Incorrect IAM authentication information: verify signature

fail;SDK-HMAC-SHA256 Access=071fe245-9cf6-4d75-822d-c29945a1e06a, SignedHeaders=host;x-sdk-date,
Signature=b2ef2cddcef89cbfe22974c988909c1a94b1ac54114c30b8fe083d34a259e0f5;canonicalRequest:GE

E
/app1/
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APl ZZ18r

5 FE g

SER2

S$ER3

host:test.com
x-sdk-date:20190126T033427Z

host;x-sdk-date

e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855, client: 192.168.0.1, server:
shubao, request: "GET /app1 HTTP/1.1", host: "test.com"

B TENEE S EIS PR S N 5EI=E Finit&RYcanonicalRequest, BFMESSDKH
it&canonicalRequestfIfI BN T :

£ 5-1 EES SDK #11+&E canonicalRequest B9 E

5= g

java libs/java-sdk-core-..* jardh
com.cloud.sdk.auth.signer.DefaultSigner.classFAgsigniR ]

c signer.cHRAYsig_signERE .

C++ signer.cpp?fAJSigner::createSignature R

c# signer.csHYSIgnERIE]

go signer.gosRHYSigNEREL

JavaScri | signer.jsAfgSigner.prototype.SigniERiEL
pt

python | signer.py®f9SigniR#] .

php signer.phpsRAYSignER L .

fian, 7Rz E3REXEIcanonicalRequest.,

POST
/app1/

host:test.com
x-sdk-date:20190126T033950Z

host;x-sdk-date
e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855

LR BTN 2H R canonicalRequest2H— o
o =, iBKEappsecretsliskER1ER., (EWIER: appsecretdisk P SET =g )

e o

- BTFRE: BERLEEFRE—H.

- B2IARE: ERBERERE—H.

- B3IARE: BERSHERES—H.

- BA5TARRE: BRAER, BITHERE—E

- BVIARE: BREISHBINHENMERLERITHRS—H.
- H8ITAME!: iBERbodyERIF—H
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5 FE g

& 5-2 LI APl EFIZ Fimit&RY canonicalRequest

T | &% APIRIZE EF g

1 BKAE GET POST

2 BERER /app1/ /app1/

3 BRSE = =

4 BRLER host:test.com host:test.com

5 BRLER x-sdk- x-sdk-
date:20190126T03342 | date:20190126T033950Z
77

=17 - ;

7 1ERLSEZ5FE | host;x-sdk-date host;x-sdk-date

8 iB3RkbodyAJhash{& | e3b0c44298fc1c149af | e3b0c44298fc1c149afbf4c89
bf4c8996fb92427ae41 | 96fb92427ae41e4649b934ca
e4649b934ca495991b | 495991b7852b855
7852b855

----85R

BiEZ: AEEFRBIT

THijshRAE, EETNHMEZSDK, REEZFRHE,

BRIEEREE, ERNSGEITH “demohtml” 324,
IRENx-sdk-datefd, x-sdk-datefE/RS=HFIRIEHEZTE15minkARN .

$E1
$2
$IE3

1. EREHPIET “F127 , HERMBEHIEE “Sources > Snippets > New
snippet” ,

2. BUTRBEHZEIGMAIScript snippetdh, ABRTELMAHEScript snippetZ iR,
% “Run’” 5,

“Console” H3TEPHYEFLZX-sdk-date(E,

twoChar (date getUTCMonth

ar() + twoChar(d 1) + twoChar(date. ge
}) + twoChar(date . getUTCHinutes StUTC

1) tUTCDate()) + "T" +
woChar(date. getUTCSeconds () + “Z"

S5

function twoChar(s) {
if (s >=10) {
return "" +s
}else {
return "0" +s
}

}
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function getTime() {

var date = new Date();

return "" + date.getUTCFullYear() + twoChar(date.getUTCMonth() + 1) + twoChar(date.getUTCDate()) +
e

twoChar(date.getUTCHours()) + twoChar(date.getUTCMinutes()) + twoChar(date.getUTCSeconds()) +

nzn
}
getTime()

F4 Bx-sdk-dateifhNFIHeadersd, HIESHSS%, 8F “debug” FKINESZF/HE.

Apigateway Signhature Test

Key Secret

6cc7e004261645c4bc954268d3b49528 2954368c3b495286cc720042e1645¢c4bc

Method url

GET 3

Headers

X-Sdk-Date 20221208T015751Z

%

| |

curl -X GET "mmg fget” -H "X-Sdk-Date: 20221208T015751Z" -H "host: ' -H "Authorization: SDK-HMAC-SHA256 Access
=6¢c7e0042¢1645c4bc954368d3b495a8, SignedHeaders=host;x-sdk-date, Signature=488409e25642fd03753a16238f89¢35b466e93b3470160a92834f5

‘Nole: accessing the API from browser requires support for CORS
rejected

host:
x-sdk-date:20221208T015751Z

host;x-sdk-date
e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855

SDK-HMAC-SHA256
20221208T015751Z
d66ff33d28fa397f5746dbbdc6f7a34fbfb0edf0229a5415d92fca5bag6240dc

SDK-HMAC-SHA256 Access=6cc7e0042e1645c4bc954368d3b495a8, SignedHeaders=hostx-sdk-date, Signature=488409¢25642fd03753a16238f89e35b4
66e93b3470160a9e894f53e79f2108a

JEget\delete\headiEsk, TEEHbodylk, FEE LEBodytEFFMbody (&5
Ki%iEKAIbody—2 )

285 SHSBRAEPcurlas S, EemddsSiTHIT, caurliSHiTREBR#HITTI—2,
curl -X GET "http://192.168.0.1:10000/get" -H "X-Sdk-Date: 20221208T015751Z" -H "host:
192.168.0.1:10000" -H "Authorization: SDK-HMAC-SHA256 Access=6cc7e0042e1645c4bc954368d3b495a8,

SignedHeaders=host;x-sdk-date,
Signature=488409e25642fd03753a16238f89e35b466e93b3470160a9e894f53e79f2108a" -d $"

WNERBE M authorization, NEEBcurlas$ EEAIAuthorizationZia B EN Z
FRo

ZE6 WRAMHABHERZERS|sHMMEERER.

FlanHEEjavaiE S & &8 FAYcanonicalRequest. stringToSign.
authorizationHeader(#, S5jseJiitEEFZHFREE—H.
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codingException

String messageDigestContent = calculateContentHash(request)

Stringl

signedHeaders = getSignedHeaders(request)

String canoni

[1 signingKey = deriveSigning

-

Incorrect IAM authentication information: AK access failed to reach the
limit, forbidden
{

"error_msg": "Incorrect IAM authentication information: AK access failed to reach the
limit,forbidden." ......

"error_code": "APIGW.0301",

"request_id"; "R

}

BIEEEES

o akskEZITEEIR, iB2%Incorrect IAM authentication information: verify
aksk signature failf2R753%,

o  akXIRZAISkAILEL

o akskMEHDEANLEE, ELELEIRSRAL, EESHHP (SO HHREIEY, 1R
AR FERIERER) -

e tokenfEiXHT, tokeniZHA,

Incorrect IAM authentication information: decrypt token fail
{

"error_msg": "Incorrect IAM authentication information: decrypt token fail",
"error_code": "APIGW.0301",
"request_id"; "R

}
EEEES
FAPRIAPIEREIAMIAIE, TOKENARHTEEML,
RRRINE

o (EEIRENtokendIF5iE, tokenEREIEH .

STRERRA 01 (2024-02-18) IREUE © ERREARBIRAS 55



APl &£Z15R 5 FE g

o 1QEFKEtokenfIMME SEARIMERE

Incorrect IAM authentication information: Get secretKey failed
{

"error_code": "APIGW.0301",
"request_id"; "rrrERE

}
BEEEES

FAFHIAPIEREIAMIAIE, fEREAK/SKEZHINIAE, (BRAKREE.
RIS E

MEBEAKESEE1EM,

o R — H S
5.7 APP AIEHSEEIR
APPINIEERIRIRE
e Incorrect app authentication information: app not found, appkey xxx

e Incorrect app authentication information: verify signature fail,
canonicalRequest

e Incorrect app authentication information: signature expired

Incorrect app authentication information: app not found, appkey xxx
{

"error_msg": "Incorrect app authentication information: app not found, appkey
01177c425f71487ea362ba84dc4abe5e1",

"error_code": "APIGW.0303",

"request_id": "a5322eb89048eb41d705491a76a05aca"

}

AlRERE
appkeyBt E{EIR .
BRI

1 FAPINXEHISRENAEMSHMZRIEE “APISE > SIESR”
T2 BEWNAERESR, HEANEREES.
$E3 BF “Key” H, HEHFHFEHappkey,

-

Incorrect app authentication information: verify signature fail,
canonicalRequest
{

"error_msg": "Incorrect app authentication information: verify signature fail, canonicalRequest:GET|/test/||
host:d7da6fe436fb48f2af3c5c2e5b203df7.example.com|x-sdk-date:20230527T015431Z||host;x-sdk-date|
e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855",

"error_code": "APIGW.0303",

"request_id": "cb141a91c945e68950a14a8eff5d62dc"

}
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GRS
FBRNLEE L FRAEOH, ERiRITENERERSAPINKITENEZERERE.
BRAE

iB2%Incorrect IAM authentication information: verify aksk signature fail,

Incorrect app authentication information: signature expired
{

"error_msg": "Incorrect app authentication information: signature expired, signature
time:20230527T000431Z,server time:202305277020608Z",

"error_code": "APIGW.0303",

"request_id": "fd6530a01c09807640189e65e837b8ad"

}
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5.8 "The API does not exist or has not been published
in the environment."{o[fFR?

EFAAPIRX R FIAIAPIREE, BIRIA TINFRIE R sERE:

1. AFAPIER{ERARIESE . BKRGIE. BIEARER,

- LLUNGUEAIAPIAPOSTS A, BMER T GETHIERAMA.

- HEEniAIaAIURLELAPEBHRAIURLD— /7 B2 ST AILE EIHAPI,
f5lanhttp://7383ea59c0cd49a2b61d0fd1d351a619.apigw.region.cloud.com/
test/F0http://
7383ea59c0cd49a2b61d0fd1d351a619.apigw.region.cloud.com/test&ILED
EARERIAPI,

2. APLRERM. APIRIZE, FEAMIBERNIMNEEAEER. BNEMEESE
7§¥EAPIO MREHBEFEEFRIE, 1EIEK “X-Stage” 2B NRMBAINE
3. BRI ALLEN. ANRAPIRIEE . 15KDA. BREH, BERHMIIKE, B

BER IR B ERRITEERIAPIFRTEDH . IBIEAPIFIENS A, flEe2

PMAPIDEE, BNDEEECHMRIINE, APIERE, AT HEMS BRI

Bo

4. KEAPIZEEFOPTIONSEEIER, WNIRFEROPTIONSIESIHIERK, IBEAPIFFF

JECORS, FHEIFEOPTIONSHUAIAPI, BEME(FESEHREREE.,
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https://support.huaweicloud.com/intl/zh-cn/usermanual-apig/apig_03_0014.html
https://support.huaweicloud.com/intl/zh-cn/usermanual-apig/apig_03_0011.html
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